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 Safety Precautions
 (Be sure to read this before the training.)

Before designing a system, be sure to read this manual and pay close 
attention to safety.
During the training, pay attention to the following points to ensure 
correct handling.

  To prevent electric shock, do not touch the terminals while they are 
powered ON.

  Before removing safety covers, either turn the power supply OFF or 
confirm safety.

  Do not put your hand into moving parts.

[Precautions for Training]

DANGER

  Proceed with the training under the guidance of a teacher.

  Do not remove the training machine module or change the wiring 
without permission. Doing so may result in malfunction, misoperation, 
injury or fire.

  Before attaching or detaching the module, turn the power OFF. 
Attaching or detaching the module while it is still ON may cause the 
module to malfunction or cause an electric shock.

  If unusual odor is detected with the training machine (X/Y table, etc.) 
immediately turn the power switch to OFF.

  If an abnormal event occurs, immediately contact your teacher.

CAUTION



This text book introduces basic knowledge you should be aware of for 

sequence control together with simple examples for first-time users of 

PLCs.

Descriptions in this text book are primarily for the teaching material FX-I/O 

demonstration model that uses the micro PLC FX1S-14MR type.

The following shows related materials:

(1)   FX1S Hardware Manual ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ JY992D83901

(2)   FX Programming Manual 

       (FX1S, FX1N, FX2N, FX2NC) ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ JY992D88101

(3)   FX-10P Operation Manual (Operation Procedures)

                                                                            ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ JY992D33401

INTRODUCTION

This document does not guarantee the implementation of industrial 

copyright and other rights, nor authorizes rights of implementation. 

Also, MITSUBISHI ELECTRIC CORPORATION cannot assume any 

responsibility whatsoever for problems in terms of industrial copyright 

that may arise by use of the content described in this document.

© 2006 MITUBISHI ELECTRIC CORPORATION

1



1.1 What Is "Sequence Control?" ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ 4

1.2 Devices Associated with Sequence Control ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ 6

1.3 Items Required for Sequence Control ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ 8

1.4 Performing Wiring Based on Sequences ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ 11

1.5 Let's Remember Sequence Symbols ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ 16

2.1 What is a "PLC?" ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ 18

2.2 How PLCs Work ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ 19

2.3 Wiring and Programs ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ 23

2.4 Advantages of Using PLCs ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ 24

4.1 Introductory Example 1 (Control of Escalators) ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ 43

4.2 Introductory Example 2 (Control of Tea Dispenser) ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ 45

4.3 Introductory Example 3 (Control of Drilling Machine) ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ 47

4.4 Introductory Example 4

      (Control of Quiz Answer Display Panel) ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ 49

Appendix 1 The OPERATION OF THE GX Developer ⋅⋅ 51

Appendix 2 SFC Program  Outline ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ 99

Appendix 3 Training Machine's I/O wiring Example ⋅⋅⋅⋅⋅ 101

3.1 Let's Remember PLC Instructions ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ 28

          LD, LDI, OUT, END

          SET, RST

          AND, ANI

          OR, ORI

          ANB

          ORB

          NOP

3.2 Order of Programs ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ 38

3.3 About Timer Circuits ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ 39

3.4 About Counter Circuits ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ 40

3.5 About Self-hold Circuits ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ 41

Chapter 1  WHAT IS "SEQUENCE CONTROL?" 

Chapter 2  WHAT IS A "PLC?"  

Chapter 3  SEQUENCE INSTRUCTIONS 

Chapter 4 PROGRAM TRAINING  

Appendices  

Contents

2



 Let's Learn About Sequences
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Let's learn about sequence control
Sequence control is a word that we ordinarily do not hear often. Yet, it exists all  

around us and we have contact with it in our day today lives.

For example, a fully automatic washing machine is an excellent example of 

"sequence control."

In this chapter, we will consider what "sequence control" is and the affect it has 

on our daily lives.

WHAT IS "SEQUENCE CONTROL?"
Chapter 1
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1.1 What Is "Sequence Control?"

What does "sequence" mean?
Though the word "sequence control" may generally be unfamiliar to us, it is used 

very often around us, and everyone is likely to have seen or have had contact 

with something that is controlled by sequence control.

Dictionaries describe the word "sequence" as follows:

From this, we can understand that "sequence" refers to a succession or order in 

which events occur.

Examples of things you are familiar with
Let's consider an example of a car wash you frequently catch sight of at a gasoline stand.

(1) State or fact of being sequent or consequent

(2) Succession 

(3) Order of succession 

(4) A series of things following in order, etc. 
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Though operation of the car wash on the previous page was described in 

approximate terms, this order is the basic way of thinking behind sequences, and 

making this sequence operate correctly and automatically countless times as 

intended becomes sequence control.

Sequence control is used extensively and is a vital approach in all situations and 

all fields.

Sequence control is used not just in complex applications but also in applications 

very familiar to us.

Household electrical appliances Elevator

Factory

Power substationsAutomatic vending machines

Sequence control is usedin a wide range of fields.
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1.2 Devices Associated with Sequence Control

Component devices in sequence control
The following devices are used to perform sequence control.

These devices can be broadly classified as follows:

   "devices operated by personnel"

   "devices that notify personnel of machine states"

   "devices that detect machine states"

   "devices for making machines move"

Various devices are also combined to perform sequence 

control in a car wash, for example.

Devices for making machines move

Devices operated by personnel Devices for detecting machine states

Start/stop buttons, etc.

Devices for notifying personnel of machine states

In-operation lamps, etc.

Switches, etc. for detecting arrival of vehicle

Personnel
Devices operated by personnel Devices for notifying personnel of machine states

Switches, etc. Lamps, buzzers, etc.

Pumps for discharging

detergent or water, and 

motors, etc. for rotating 

brushes
Start

Stop

Sequence
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The devices shown in this figure are just examples and only a few of many such 

devices.

In sequence control, combinations of devices such as these are made to operate 

in accordance with a work procedure.

Of these devices, "devices operated by personnel" and "devices for detecting 

machine states" become the conditions for making things move in sequence 

control, while "devices that notify personnel of machine states" and "devices for 

making machines move" are the devices that are operated in accordance with 

these conditions.

Operation panel ⋅⋅⋅⋅⋅⋅ A panel on which "devices operated by personnel" 

(pushbutton switches, selector switches, etc.) and 

"devices for notifying personnel of machine states" 

(lamps, digital displays, etc.) are installed.

Control panel ⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅⋅ A panel on which devices, such as electromagnetic 

contactors, relays and PLCs, for controlling machine 

movement, are installed.

Magnetic contactors, relays, etc.

Devices for detecting machine states Devices for making machines move
Machine

Limit switches, proximity switches, etc. Motors, solenoid valves, etc.

Though small-load devices such as 

small-size solenoid valves and pilot 

lamps can be driven directly by a PLC, 

large-load devices such as large-size 

solenoid valves must be driven via an 

electromagnetic contact or relays.

Control
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1.3 Items Required for Sequence Control

Let's actually consider sequence control.
Now, let's try actually considering sequence control based on the connection 

diagram below. The following also describes the terms you need to know in 

learning sequence control.

 The electrical circuit below is wired using a pushbutton switch and       

                     lamps (blue, red).

    Content of sequence control

(1)When the pushbutton switch is not pressed, electricity flows along route B 

     and the blue lamp is lit.

(2)When the pushbutton switch is pressed, electricity flows along route A and     

     the red lamp lights.

(3)When the pushbutton switch is released, the blue lamp lights again as in (1) above.

     The operations in (1) through (3) are part of sequence control.

Example 1

Connection diagram

Pushbutton
Blue lamp

Red lamp

Relay

Power s
upply
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Let's learn some new terms.
The following describes the relay on the page on the left.

   About relays

    A relay is a simple electromechanical switch made up of an electromagnet and             

    a set of contacts .

   About contacts

     Where are relays used?

(1) Relays can make large motors and lamps operate by using small signals.

(2) Relays can make motors and lamps in remote sites operate.

Relay Cross Section

Moving contact Moving contact

Fixed contact

12VDC(direct current)

100VAC(Alternate currect)

Magnet
Flow of

electricity

Magnet

When electricity flows to 

the magnetic, the moving 

contact is actuated.

A "contact" is a contacting part that performs switching operation,  and 

allows electricity to pass or blocks electricity. Other forms of contacts were 

found in switches, timers, counters and other devices. There are two types 

of contacts, N.O. contacts and N.C. contacts. (See next page)
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    About contacts

Contacts perform a switching operation to block electricity or make parts conduct. 

Basic contacts are N.O. contacts and N.C. contacts, and switches, relays, 

timers, counters and other devices have contacts.

A "N.O. contact" is a "normally open" contact, and closes when an instruction 

(Note 1) is made to the contact.

A "N.C. contact" is a "normally closed" contact, and opens when an instruction is made.

Pushbutton

Pushbutton

Moving contact

Moving contact

Moving contact

Moving contact

Press button

Press button

Fixed contact

Fixed contact
Fixed contact

Flow of

electricity

Flow of

electricity

Fixed contact

Wiring

Wiring
WiringWiring

Circuit

closed
Circuit

open

Wiring

Contact

Wiring
Spring

Spring Spring

Before button is pressed (in return position) After button is pressed (in operating position)
Spring

Circuit

open

 Note 1   An "instruction" here means "causing an operation or change." The operation of

              pressing a pushbutton corresponds to an instruction.

N.O. contacts

N.C. contacts

Operation: In the case of a pushbutton switch

                   When the pushbutton switch is not pressed, the contact is open.

                   When it is pressed, the contact closes.

Operation: In the case of a pushbutton switch

                   When the pushbutton switch is not pressed, the contact is closed.

                   When it is pressed, the contact opens.
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Red lamp

Blue lamp

Relay

Figure 1.Blue lamp

Figure 2.Red lamp

Wiring diagram

Red

Lamp 1

Lamp 1

Common contact N.C. contact Relay

Coil

P
u
sh

b
u
tto

n

Pushbutton switchN.O. contact

Lamp 2

Lamp 2 24VDC power supply

Blue

Red

Lamp 1

Lamp 1

Common contact N.C. contact Relay

Coil

P
u
sh

b
u
tto

n

Pushbutton switchN.O. contact

Lamp 2

Lamp 2 24VDC power supply

Blue

Pushbutton

DC power supply

Product configuration

1.4 Performing Wiring Based on Sequences

Now that you've learned some new words
Let's train using Example 1 on page 1-6

that we studied for relay contacts.

    Outline of relay-wired training

    demonstration model

Power cable           1 pc

Pushbutton             1 pc

Blue lamp                1 pc

Red lamp                1 pc

Relay                       1 pc

Wires (brown, red, orange, yellow,

                  green, blue, purple, gray)       1 each 

Note) In this example, power supply terminals

          No.4 and No.5 are common terminals.

     2     What is an "actual wiring diagram?"

   Let's wire the training demonstration model.

1. Make sure that the training 

    demonstration model is turned OFF.

2. Wire the blue lamp in Figure 1 by 

    connecting the wires as follows:

    Purple wire to No.7 terminal

    Yellow wire to No.4 terminal

    Gray wire to No.8 terminal

3. Wire the red lamp in Figure 2 by 

    connecting the wires as follows:

    Green wire to No.5 terminal

    Blue wire to No.6 terminal

    Brown wire to No.1 terminal

    Red wire to No.2 terminal

    Orange wire to No.3 terminal

This refers to a diagram that is as close 

as possible to the real thing and that 

shows circuit connections and devices 

used for the circuit. As wiring and the 

structure of devices can be accurately 

seen in this diagram, it is handy when 

actually manufacturing devices or 

performing maintenance.

2
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Now that you've learned some new terms and phrases

   Let's check operation

    Let swap the content of sequence control explanation on page 1-6 with the new  

    terms and phrases you've learned.

(1) When the power is turned ON, the N.C. contact and route B is made , and the 

blue lamp is turned on.

(2) When the pushbutton switch (N.O contact) is pressed, the action of the relay 

causes the N.O. contact to close. Route A is made , and the red lamp is turned on.

(3) When the pushbutton switch is released, the blue lamp is turned on again as in (1) 

above.

What is a "flow chart?"

With sequence control, various devices are combined to comprise a circuit. To 

explain, the control of these devices can become quite difficult using based 

methods. Therefore a flow chart is a preferred method for explaining a control 

sequence.

A flow chart uses rectangular symbols and arrows to more simply express the 

overall order of related operations.

What is a "time chart?"

A time chart expresses changes in the operation sequence over time.

The devices to be controlled are drawn on the vertical axis, while changes over 

time are drawn on the horizontal axis. Dotted lines with arrow heads are used to 

show the relationship between respective devices and resulting operations.

Time charts sometimes express changes over time without the use of arrows.

You can also learn the content of sequence control from flow charts and time charts.

p

Sequence expressed as a flow chart

Sequence expressed as a time chart

Power ON
Blue lamp  Lit

Red lamp  Out

Blue lamp  Out

Red lamp  Lit
Pushbutton

switch pressed?
Pushbutton
switch not
pressed?

NO

Pushbutton

Relay

Pressed Released

Blue lamp

Red lamp

Pushbutton

NO

YES

YES

Closed

Operating

Lit

Lit Lit

Relay
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An actual wiring diagram is a diagrammatic means of making the structure of devices 

and wiring easy to understand. However, the operation sequence is harder to follow 

in actual wiring diagrams for complex electrical circuits.

Let's try swapping an actual wiring diagram with a sequence diagram to illustrate this point.

Sequence diagrams are connection diagrams intended to make the content of 

operation of many circuits easier to understand. Unified standards enable this 

diagrammatic method to be easily understood by third parties.

Note) With the FX-I/O demonstration 

training machine, both relays 

and lamps are driven by a 

24VDC power supply. However, 

in general, relays are driven by 

a 24VDC power supply and 

lamps are driven by a 100VAC 

power supply. This is shown in 

the figure below.

Lamp 1

Lamp 1

Common contact N.C. contact Relay

Coil

P
u
sh

b
u
tto

n

Pushbutton switchN.O. contact

Lamp 2

Lamp 2 24VDC power supply

Actual wiring diagram and sequence diagram

6

7

8

8 3

4 4 5 7 1

1

2
26

35

Wiring Diagram

Sequence Diagram

DC power supply

PB
RELAY

Pushbutton switch Relay coil

RELAY (N.C. contact)
Blue

BLUE

RED

Red
RELAY (N.O. contact)

AC power supply
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Let's consider another example

Transfer pump

Pump

Well

Full

L
S

1
 O

F
F

L
S

2
 O

F
F

O
p
e
ra

ti
o
n

S
to

p

M
o
to

r

Empty

Water

level

Tank

LS2 (N.C. contact)

Float switch turns OFF

when tank is full.

LS1 (N.O. contact)

Float switch turns ON

when tank is empty.

 Controlling the level of water in a tank

    

     Details of sequence control

(1) When the operation switch is closed, the float switch limit switch 1 closes if 

the tank is empty, and the magnet switch MC is operated to drive the transfer 

pump motor.

     Relay MC is designed to hold its own state even if the water level is at the mid 

position.

(2) When the tank becomes full, float switch limit switch 2 opens, hold operation 

of the relay MC is canceled, and the transfer pump motor stops.

(3) When the water level reaches the empty level, the motor starts to operate 

automatically again.

With motor operation in this control 

example, the motor starts to operate at 

the mid position after an empty tank is 

detected.

Motor operation stops at the mid 

position after a full tank is detected, 

and the motor operating state differs 

even at the mid position.

This kind of operation is called 

"hysteresis operation" and can reduce 

the number of times that motor 

operation is stopped.

Example 2

L
S

1
 O

N

L
S

2
 O

N
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Motor

power

supply

MC

Control power supply

Start switch

The start switch

stays ON even

if it is released.

(residual operation

type)

LS2   3 LS1

MC
1

M Motor

Contacting of the relay

drives the motor.

MC

Breaker

Start switch

Full Full

Water level mid position

Water level

mid position

Float switch

LS2

Float switch

LS1

Magnet

switch

The sequence in this section is generally replaced by a sequence program on a PLC.

About self-hold circuits

A "self-hold circuit" refers to an operation circuit that bypasses signals 

arriving from an external relay or other device by means of the contact of 

the relay itself.

Self-hold circuits can also be said to have a memory function that allows 

them to operate continuously even if the circuit is cut by releasing a pressed 

pushbutton.

In this circuit, the contact of the relay (MC     ) for driving the motor is 

connected in parallel to float switch limit 1 (LS1). This provides an example of 

a "self-hold switch."

Though limit switch 2 (LS2) functions to cut the self-hold circuit to stop the 

transfer pump motor, when limit switch 2 (LS2) is used with a N.C. contact, the 

switch can also be turned OFF to stop transfer of water during a switch contact 

failure or wiring break.

   Sequence diagram

Operation of self-holding circuit (time chart)

Breaker        This device breaks the 

circuit for the current when 

an abnormal current flows.

1
2

3

MC   2

N.O. contact The float switch turns ON

when the tank is empty.

Magnet

switch

N.O. contact

The float switch

turns OFF when

the tank is full.

N.C. contact

Water level mid position

Empty

Operation

Even when the float 

switch LS1 turns OFF, 

operation of the magnet 

switch continues due to 

the self-holding circuit.

2



1.5 Let's Remember Sequence Symbols

List of main sequence symbols

JIS C0617

Drive Source

Manual

Manual

Heater 

Operation

Manual

Dog    cam

Electromagnetic

coil

N.C. ContactN.O. ContactContact Category

Horizontal formatVertical formatHorizontal formatProduct Category

Pushbutton

switch

(Auto-

return type)

Pushbutton

switch

(residual

operation type)

Thermal

relay

(OCR)

Limit

switch

(general)

Limit

switch

(mechanical

operation)

Auxiliary

switch relay

contact

Magnetic

contactor

Timer

ON delay

Timer

OFF delay

Vertical format

16
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17

What is a "PLC?"
PLC stands for "programmable controller" and is sometimes known as a 

"sequence controller" or SC. These are defined as electronic devices that 

control various devices via I/O sections and have built-in memory for 

storing programmable instructions.

Actually
So far, we have performed "sequence control" by physically wiring relays 

and timers. This chapter considers the use of a simple PLC program to 

control electronic devices.

WHAT IS A "PLC?"
Chapter 2
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2.1 What Is a "PLC?"

What do PLCs do?

Personnel

Switch, etc. Lamps, buzzers, etc.

Sensors, etc. Motors, solenoid valves, etc.

Devices for notifying personnel
of machine states

Devices operated

by personnel
Sequence control

Devices for making
machines move

Machine

Devices for detecting

machine states

The devices that are operated by personnel or that detect machine states in 

sequence control are called "instruction signals" or "condition signals."

Devices that notify personnel of machine states or that move machines are 

called "loads."

PLCs are responsible for carrying out "sequence control." The diagram above 

illustrates the control of these devices. Where the condition signals and loads in 

the devices are connected to the PLC. 
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2.2 How PLCs Work

How does sequence control work?

PLCs are microcomputer-controlled devices for industry.

Devices connected to the input side of the PLC are called "input devices," while 

devices connected to the output side of the PLC are called "output devices."

One device is connected to each terminal block.

One input device and one output device may merely be connected to a PLC in 

this way, and the connection for performing sequence control is performed 

electronically inside the PLC.

PLC internal connections are programmed using dedicated sequence language 

(instructions), and a combination of these instructions is called a "sequence 

program." Sequence control is performed in accordance with this program, so 

there is no need to wire externally.

Limit switches

Relay contact

Select switch

Pushbutton switch

PLC

Input Devices

Programming

panel

Power supply

O
u

tp
u

t in
te

rfa
c
e

In
p

u
t in

te
rfa

c
e

Storage

section

Operation

section

Memory

Microcomputer

Contactor

 Lamp

Solenoid valve

 (solenoid valve)

Output Devices

Power supply
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Actually consider a PLC as a group of relays and timers

The figure above shows how the input devices, output devices and the sequence program are configured.

The input devices is connected to the PLC's input relays, and the output device is controlled via contacts for external outputs.

Input relays

Output contacts

The input relays convert the signals from an external device to signals for the 
PLC. In the above figure, the input device is designed to operate merely by 
connecting across the input terminal and the COM terminal.
However it should be noted that PLCs have a limited number of contacts, even 
though, an infinite number of contacts is provided on the sequence program.

The PLC has a built-in power supply 

for the input relays. When the 

contact of the input device is 

conducting, current flows along the 

dotted line to drive the input relay. 

When the output relays on the 

sequence program are driven, the 

contacts for external output close.

Provide a power supply for driving 

the external device outside the PLC.

Regardless of whether the external input device is a N.O. contact or a N.C. 
contact, the contact on the PLC that closes when the COM and input terminals 
are conducting is an N.O. contact, and the contact that opens is a N.C. contact.

Output contacts are otherwise known as just outputs. These are coutrolled by 
the sequence program, and are necessary for driving an external load.
Devices having a different power supply (AC or DC) can be connected to the 
contacts for external output. 

Input relays operated

by external signals

Sequence program operated

by input relay contacts

Output of output

relay operation

External load

operated

Power

supply

Output relays

Timers

Auxiliary relays

Contacts for

external outputs
Input relays

PLC

Operation

Operation

PB1

LS1

PB2

X001

Y000

X001

X005

M100

X007

K100

X003

Output relays

Timers

Auxiliary relays

COM

X000

X001

X002

X003

X004

X005

X006

X007

X001

X003

X005

M100

T    0

Y100 Y000

Y001

Y002
Y002

Y000

Y000

PL

MC

Y001

Y001

Y002

Y003

Input device

COM

Input relay

PLC

Input terminal

COM

PLC
Output device

Power supplyContacts for external outputs

Output terminal
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An I/O number is assigned to each terminal to make the I/O devices connected 

to the input terminals and output terminals correspond to the input relays and 

output relays of the sequence program.

Timers and counters held internally by the PLC are also assigned to devices 

numbers in addition to each terminal number.

Element numbers ⋅⋅⋅⋅⋅⋅ Element numbers comprise a symbol that shows what the   

devices is and a number that categorizes individual devices.

Input relays act as the "point of contact" for 
receiving signals, for example, from an input 
switch outside of the PLC. X is used to 

identify their device number. PLCs have a 
built-in number of input relays corresponding 
to the number of inputs (number of terminals).

Input relays : X000~

Output relays act as the "point of contact" for 
driving loads outside the PLC. Y is used to 
identify their device numbers. PLCs have a 
built-in number of output relays corresponding 
to the number of outputs (number of 
terminals).

Output relays : Y000~

Timers are held internally by the PLC, 
and function to measure time. Timers 
have coils and contacts. When a 
preset time is reached, a contact 
closes.

Timers : T  0~

Counters are held internally by the 
PLC and count numbers. When a 
preset number is reached, a contact 
closes.

Counters : C  0~

Auxiliary relays are held internally by 
the PLC and are also called "internal 
relays."

The number of inputs relays, output relays, timers, counters, and other devices 
varies according to the model of PLC.

Auxiliary relays : M  0~

ReferenceReferenceReference

Decimal, Octal and Hexadecimal
As shown in the following table, octal and hexadecimal numbers are assigned as 

devices numbers in addition to decimal numbers.

Auxiliary timers, timers, countersInput relays, output relays

General-purpose Q/A Series 

Micro PLC FX Series Octal Decimal

Hexadecimal Decimal

"Decimal"

"Octal"

"Hexadecimal"

The decimal number system is used most often, and counts up numbers in 

units of ten in the format 0 to 9, 10 to 19, 20 to 29 and so forth.

The octal number system counts up numbers in units of eight in the format 

0 to 7, 10 to 17, 20 to 27 and so forth.

The hexadecimal number system counts up numbers in units of 16 in the 

format 0 to 9, 0A, 0B, 0C, 0D, 0E, 0F, 10 to 19, 1A, 1B, 1C, 1D, 1E, 1F and 

so forth.
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Expressions used in sequence diagrams and sequence programs
The sequence program on a PLC replaces the input device and output device connected 

to each of the external terminals with a circuit for performing sequence control. For details 

on instruction words, see Chapter 3.

The following explains how to replace a sequence diagram with a sequence program.

This example shows the tank water level control described on page 1-12 replaced with a 

sequence program.

The following describes the various differences when a relay sequence program 

is replaced with a sequence program.

SW

LS2 LS1

MC

MC

MC

MC

X000 X002 X001

Y000

Y000
SW LS2 LS1 

Sequence diagram Sequence program

(1) How N.O. contacts and N.C. contacts are expressed

Relay sequence diagram Sequence program

N.O. contact

(2) The power supply circuit is not expressed.

(3) The sequence program is assigned devices numbers explained in the previous 

page.

(4) Limit switch 2 in the sequence diagram is a N.C. contact but becomes a N.O. 

contact in a sequence program.

This is because the role of limit switch 2 in the above sequence diagram is to 

break the self-hold circuit of the MC and stop the MC. So, we should consider 

that it is in a conducting state at all times on the circuit.

Next, remember the operation of the input relay on page 2-4. In operation of 

the N.O. contacts and N.C. contacts in the sequence program, N.O. contacts 

turn ON and N.C. contacts turn OFF when the input relay is electrically 

conducting due to a change in state of the contact on the external wiring. Due 

to this fact, a N.O. contact must be used on the sequence program to obtain 

the same operating state.

In this way, when a PLC is used, N.O. contacts and N.C. contacts can be 

used for each of the contacts on the sequence program.

Important

N.O. contact

N.C. contact N.C. contact
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2.3 Wiring and Programs

What are PLC wiring and programs like?
The figure below shows the circuit on page 1-13.

I/O wiring must be handled in the 

conventional way using cutting pliers 

and a screwdriver.

The connections between input terminals and input relay coils and between 

output contacts of output relays and output terminals were already established at 

the delivery from the factory.

Complicated internal wiring in a PLC 

(sequence program), can be handled 

easily by operating the pushbuttons 

(keys) on the programming panel.

SW

COM

X000

COM

Fuse

Y000 MC
X000 X002 X001

Y000

Y000

X001

X002

LS1

LS2

Output wiringSequence programIntput wiring

The wiring of a PLC wiring can be divided up into I/O wiring and internal wiring.
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2.4 Advantages of Using PLCs

Effective use of PLCs

1 Economical

In general, PLC is more inexpensive than conventional control box

where 10 or more relays are required.

2 Less manpower for design

Large amount of labor-saving can be achieved through simplified parts

layout drawings, sequence design and pre-start-up and test procedures.

3 Short turn-around time

The turn-around time can be significantly reduced through reduction in quantity

of procured parts, parallel procurement of the machinery and control box,

flexibility in specification change, simplified wiring work and so forth.

4 Downsizing and standardization

Significantly reduced in size than relay boards and mass-production is

possible by reusing the program.

6 Improved maintainability

Maintenance can be done in an easy manner, since few parts with life

limitation are used and the PLC has a self diagnosis function.

5 Improved reliability

Troubles due to relays and timers can be reduced and the component

with PLC can be used without any concern once the initial set-up of the

PLC is completed.

MITSUBISHI
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Comparison with relay control

ReferenceReferenceReference

A Short History of PLCs
The device "PLC" came into being in 1968 as a result of 

commissioned development by General Motors in the United States, 

and the general market for PLCs started in the United States in the 

following year. The first domestically produced PLC made its 

appearance in Japan in 1970, yet it took six years for the first general-

purpose PLC to appear in 1976. MITSUBISHI ELECTRIC 

CORPORATION initiated the market for general-purpose PLCs in the 

year 1977, and has since made one-board PLC modules a familiar 

name on the market. Since then, it has developed the general-purpose 

PLC K series with integrated numeric value processing functions, 

which was followed by the micro PLC F series with built-in 

programmer. Today a variety of PLC products are available world wide 

that can suite an array of control applications.

1
2
3
4
5
6
7
8
9

PLC controlMethodItem Relay control

Functionality

Reliability

Versatility

Device expandability

Ease of maintenance

Range of functions

Device size

Design, production period

PLCs can be used for any kind of
control depending on the program.

Once made, devices cannot
be used for other applications.

Changeability of control

content

PLCs can be repaired merely 
by replacing modules.

PLCs can be freely expanded 
up to their full potential.

If additions and modifications 
are required they are difficult.

Analog and positioning control 
also can be performed in 
addition to sequence programs.

PLCs do not increase in size 
even in complex, advanced 
control applications.

Design is simple even for 
complex control, and it does not 
take time to manufacture PLCs.

Many drawings are required, 
and it takes time to arrange 
parts and test assemblies.

Relay control only is 
supported.

Complex control is possible
by using many relays.

Control can be programmed
however complex it is.

Only the program needs to 
be changed, and control can 
be freely changed.

No other option but to
change the wiring

Reliability is higher as the 
center of operations is made 
up entirely of semiconductors.

Though there is no problem in regular 
use, there are restrictions in faulty 
contacts and service life of parts.

Periodic inspection and 
limited service life parts must 
be replaced.

Generally, large
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SEQUENCE INSTRUCTIONS

What you have learned up till now
So far we have explained that PLCs are a collection of many relays, timers and 

counters, and that their internal sequences can be wired by key operation on a 

programming panel. When performing this wiring work, rules matched to contact 

and coil connection methods and types of coils are required. These rules are the 

instructions. 

Instructions are programmed in the format "instruction word + devices number" 

or by individual instruction words. 

This chapter introduces several of the basic instructions for programming a PLC.

SEQUENCE INSTRUCTIONS
Chapter 3



3.1 Let's Remember PLC Instructions
There are two types of peripheral devices (programming devices) for entering 

Sequence programs: devices for drawing sequence circuits on screen and 

devices for entering programs using instruction words (that is, devices for 

creating a list program). These devices differ only by program input method, 

and the program itself is the same.

The following table summarizes the instructions held by a PLC, the meanings of 

each instruction and how the circuit is indicated in a sequence program.

     and     used in circuit 

indications indicate contacts. 

Contacts are in two states, 

conducting and non-

conducting, depending on 

the ON/OFF state of input 

relays or output relays, 

auxiliary relays, timers, and 

counters.

          and    SET        show 

driving of coils.

Devices used for input 

using instruction words

Device used for input

using circuit diagrams

LD

LDI

AND

ANI

OR

ORI

ANB

ORB

OUT

SET

RST

NOP

END

Load

Load inverse

AND

AND inverse

OR

OR inverse

AND block

OR block

Out

Set

Reset

No operation

END

Bus connection
instruction,  
N.O. contact

Bus connection
instruction,  
N.C. contact

Series connection,
N.O. contact

Series connection,
N.C. contact

Parallel connection, 
N.O. contact

Parallel connection, 
N.C. contact

Series connection
between blocks

Parallel connection
between blocks

Coil drive
instruction

Retain operation,
coil instruction

Cancel retain
operation, coil

instruction

No operation

End of program End of program Return to 0 step

For deleting program or space

Symbol, Name Function Circuit Indication

28
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 Commands and Programs

Mechanism of Programs

The internal sequence for the sequence controlling is created as the sequence program with the format 

of circuit diagram (ladder diagram) and instruction list.

A program is comprised of multiple instruction codes and device numbers (operand). 

These instructions are numbered in turn. This number is referred to as step number. (Step numbers are 

automatically controlled.)

Each "instruction" is comprised of "instruction code + device number". However, there are some 

instructions without devices. Also in some cases, instruction codes are just referred to as instructions.

The max steps that can be programmed depend on the "program memory capacity" of the PLC that is used.  

For example, there is a program memory with the capacity of "2000" steps in FX1S PLC, "8000" steps in 

FX1N and FX2N, and "64000" steps in FX3U.

PLC repeatedly performs the instruction from step 0 to the END instruction. This operation is referred to as 

cyclic operation, and the time required to perform this one cycle is referred to as operation cycle (scan 

time). 

Operation cycle will be changed according to the contents of the programs and the actual operating orders, 

 rom several msec o several tens  of msec. 

The PLC program created by the format of    diagram (ladder diagram) is also stored in the program 

memory of the PLC with the format of instruction list (program list). 

The conversion between instruction list (program list) and    diagram (ladder diagram) can be done by 

using the programming software in personal computer.

X001

Y000

Y000

X003

0

4

END

X006

T1

K30

9

 Circuit diagram (ladder diagram)

Step 

number

Instruction

Instruction 

code

Device (number) 

(operand)

0

1

2

3

4

5

6

9

LD

OR

ANI

OUT

LD

ANI

OUT

END

X001

Y000

X003

Y000

Y000

X006

T1  K30

 Instruction list (program list)

R
e
p
e
a
t 
o
p
e
ra

ti
o
n

tranging

circuit

circuit



Preparing for programming 
1. Open the connector cover on the top of 

the PLC.

2. Connect one end of the FX-20P-CAB0 

cable to the HPP connector on the PLC, 

and the other end to the cable connector 

on the FX-10P.

3. Set the PLC's RUN (operation) input to 

the stop side.

4. Turn the PLC ON. As the HPP 

(programming device) does not have its 

own  power supply, power is supplied to 

the HPP via the program cable.

5. Program by the following procedure.

FX1S PLC

Insert in direction 
marked by triangle 
mark.

HPP main unit

Connector for 
HPP connection

Repeatedly press
this cursor key.

Connector cover

RUN/STOP switch

Triangle mark

FX-20P-CAB0 type 
program cable

Program all clear

HPP Operations

These function selection keys are switched 

alternately and preference is given to the 

last press of the key. For example, when 

the key is first pressed, the 

mode is the Read mode. When it is 

pressed twice, the mode is the Write mode. 

When it is pressed three times, the mode is 

the Read mode.

The top row on these keys indicates an 

instruction word, while the symbol on the 

bottom row indicates a devices symbol or 

number. The HPP automatically judges 

operation of these keys according to the 

operation procedure. To correct a 

misoperation, press the key.

ReferenceReferenceReference

Clear 

Read/Write 

Read
/

Write

Insert
/

Delete

Monitor
/

Test

Clear

30



OUT

END
List programCircuit program

Output Y000 turns ON when input X000 is ON.

Output Y003 turns ON when input X003 is OFF.

OFF

ON

ON

ON

The LD (Load) instruction is used 

for the first N.O. contact used on 

the bus, and the LDI (Load 

inverse) instruction is used for 

N.C. contacts. Contact 

instructions such as LD and LDI 

are used for devices such as 

input relays X, output relays Y, 

timers T, counters C, and 

auxiliary relays M.

Coil drive instructions such as 

OUT are used for devices other 

than input relays X.

OFF

OFF

ON

OFFInput  X 000

By the above program...

Output  Y 000

Output  Y 003

OFF

(Note 1) 

(Note 2) 

0 LD X 000

OUT Y 000

LDI X 000

OUT Y 003

END

1

2

3

4

Step Instruction

0

X 000

OUT(Note 2)LD(Note 1)

LDI(Note 1)

This is called a "bus".

X 000

2

4

Y 000

Y 003

END

LD

LDI

Bus connection 

instruction for N.O. 

contacts

Load

Bus connection 

instruction for N.C. 

contacts

Load inverse

Coil drive instruction

Out

Instruction used for 

the end of a program

End

Step numbers

Step numbers indicate the order and 

size of a program.

If you program instructions in the 

order of the list program, the PLC will 

automatically assign the step 

numbers.

31
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SET

RST
Circuit program

Output Y000 turns ON when input X001 is turned 

ON.

After this, the operation state of Y000 is held at 

ON even if the state of input X001 changes from 

ON to OFF.

Output Y000 turns OFF when input X003 is 

turned ON.

ON

ON

These instructions drive 

coils like the OUT 

instruction.

With the OUT instruction, 

coils programmed with 

the OUT instruction also 

turn OFF when the 

contact that drives the 

coil changes state from 

ON to OFF. However, 

when the SET (Set) 

instruction is used, the 

operation state of the coil 

is held at ON even if the 

state of the contact 

changes from ON to 

OFF.

The RST (Reset) 

instruction is used to 

change the state of the 

coil driven by the SET 

(Set) instruction from ON 

to OFF.

ON

Input  X 001

By the above program...

Input  X 003

Output  Y 000

List program

0 LD X 001

SET Y 000

LD X 003

RST Y 000

END

1

2

3

4

Step Instruction

The SET/RST instructions are 

used for output relays Y and 

auxiliary relays M, for example.

The RST instruction is also used 

for counters and retentive timers.

0

X 001

X 003

2

4 END

RST

SET Y 000

Y 000

Operation hold 

output instruction

Set

Operation hold 

cancel instruction

Reset
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List programCircuit program

Output Y000 turns ON when input X000 is ON, 

X001 is ON and X002 is OFF.

Output Y003 turns ON when input X000 is ON, 

X001 is ON, X002 is OFF, and X003.

OFF

ON

ON

The AND (AND) instruction is 

used for N.O. contacts and the 

ANI (AND Inverse) instruction 

is used for N.C. contacts 

connected serially following 

the LD and LDI instructions.

Y000 and Y003 operate when 

all contacts serially connected 

that are driving AND and ANI 

are conducting.

        The contact instruction   

        for this position is AND or

        ANI.

ON

Input  X 000

By the above program...

Input  X 002

ONInput  X 001

ONInput  X 003

ONOutput  Y 000

ONOutput  Y 003

0 LD X 000

AND X 001

ANI X 002

OUT Y 000

X 003AND

Y 003OUT

END

1

2

3

4

5

6

Step Instruction

0

X 001

AND ANI

X 002X 000

AND(Note 1)

X 003

6

Y 000

Y 003

END

AND

ANI

Series connection 

instruction for N.O. 

contacts

AND

Series connection 

instruction for N.C. 

contacts

AND inverse

(Note 1) 
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OR

ORI

List programCircuit program

Output Y000 turns ON when even one condition, 

input X000 ON, X001 ON or X002 OFF, is 

satisfied.

OFF

ON

ON

The OR (OR) instruction is 

used for N.O. contacts and the 

ORI (OR Inverse) instruction is 

used for N.C. contacts 

connected in parallel following 

the LD and LDI instructions.

Output Y000 in the figure on 

the left operates when even 

one of the contacts connected 

in parallel that is driving OR 

and ORI is conducting.

ON

Input  X 000

By the above program...

Input  X 002

ONInput  X 001

ONOutput  Y 000

0 LD X 000

OR X 001

ORI X 002

OUT Y 000

END

1

2

3

4

Step Instruction

0

X 001

X 002

X 000

4

Y 000

END

Parallel connection 

instruction for N.O. 

contacts

OR

Parallel connection 

instruction for N.C. 

contacts

OR inverse
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ANB

List programCircuit program

Y000 operates when either of input X000 or X001 

and either of X002 or X003 are ON 

simultaneously.

ON

The ANB (AND block) 

instruction is used to serially 

connect a circuit to which 

contacts are connected in 

parallel as shown in the figure 

on the left. A devices number 

is not assigned to the ANB 

instruction. In programs like 

this, the contact for input X002 

also becomes an LD 

instruction.

X001 and X003 become OR 

instructions as these are 

contacts connected in parallel 

to X000 and X002 that are LD 

contacts.

ON

Input X 000

By the above program...

Input X 002

ONInput X 001

ONInput X 003

ONONOutput Y 000

0 LD X 000

OR X 001

LD X 002

OR X 003

ANB

Y 000OUT

END

1

2

3

4

5

6

Step Instruction

0
ANB

X 002

LD instruction also from 

beginning of branch

Parallel circuit block

OR instruction before 

ANB instruction

X 000

X 003X 001

Y 000

END

Series connection 

instruction for 

parallel circuit block

AND block
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ORB

List programCircuit program

Output Y000 operates when either inputs X000 

and X001 are simultaneously ON or when inputs 

X002 and X004 are simultaneously ON.

ON

The OR and ORI instructions 

connect a single contact in 

parallel to the previous LD 

contact. However, as shown in 

the figure on the left, the ORB 

(OR block) instruction is used 

to connect a circuit, to which 

contacts are connected in 

series, in parallel.

A devices number is not 

assigned to the ORB 

instruction.

In programs like this, the 

contact for input X002 also 

becomes an LD instruction.ON

Input X 000

By the above program...

Input X 002

ONInput X 001

ONInput X 003

ONONOutput Y 000

0 LD X 000

AND X 001

LD X 002

AND X 003

ORB

Y 000OUT

END

1

2

3

4

5

6

Step Instruction

0

ORB

Series circuit block

Y 000

END

Parallel connection 

instruction for series 

circuit block

OR block

X 001X 000

X 003X 002
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NOP No operation 

instruction

When an all clear has been performed on a program, all instructions become 

NOP.

The PLC ignores NOP instructions inserted between general instructions. 

However, be sure to delete NOP instructions as much as possible as they use up 

unnecessary program steps and make it longer to calculation programs.

No operation

Time for a break!
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A program like the one above is made using 16 program steps, (1) to (16).

The following shows the above program rewritten as a list program.

3.2 Order of Programs

Program order
Circuit diagrams are programmed from left to right and from top to bottom.

0

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

LD

OUT

LD

OR

AND

OUT

OUT

LD

AND

LD

AND

ORB

OUT

OUT

OUT

END

X 000

Y 000

X 001

X 002

X 003

Y 001

Y 002

X 004

X 005

X 006

X 007

Y 003

Y 004

Y 005

Step Instruction

Y 000

Y 001

Y 002

Y 003

Y 004

Y 005

END

X 000

(1)

X 001

(3)

X 003

(5)

X 002

(4)

X 004

(8)

X 005

(9)

X 006

(10)

X 007

(11) (12)

(2)

(6)

(7)

(13)

(14)

(15)

(16)
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3.3 About Timer Circuits

0

1

2

5

6

7

Timers
Reference

Timer program

Of the various timers available, this section 

describes how to program a digital timer that 

is held internally on a micro PLC.

LD

OUT

OUT

SP

LD

OUT

END

X 000

Y 000

T0

K 100

T0

Y 003

Timer program

Enter set value

X 000

K 100

(10 secs)

T     0

0

5

7

Y 000

T0

END

Y 003

The timer contact operates after a 

preset delay has elapsed after the 

coil has been made conductive. 

(ON delay timer)

This preset time is called the "set 

value" and is expressed as K 

which can be set in the range 1 to 

32,767.

For example, K100 is a timer of 

ten seconds.

When X000 is turned OFF while 

the timer is being driven, the 

present value of the timer returns 

to "0" and the timer contact also 

turns OFF.

Key operation

Monitor

mode

M

Let's try using monitor functions.

By the above program...

Monitor

/

Test

When the monitor mode is selected, "M" is 

displayed at the top left of the FX-10P screen.

ON

ON

Input  X000

Output  T0 (N.O. contact)

ONOutput  Y000, T0 (coil)

ONOutput  Y003 (coil)

10 secs

Step Instruction

input from 
Personal  
Computer

OUT   T0   K100,
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3.4 About Counter Circuits

Counters

Counter program

Of the various counters available, this section 

describes how to program a general-purpose 

counter that is held internally on a micro PLC.

0

1

3

4

7

8

LD

RST

LD

OUT

SP

LD

OUT

9 END

X 001

C0

C0

X 003

K   10

C0

Y 003

Counter program

Enter set value.

Counters count the number of 

times a contact (X003) changes 

state from OFF to ON.

This contact (X003) is called the 

"count input," and the value 

counted by the counter is called 

the "present value."

The counter operates when the 

present value reaches the 

specified number (set value).

The set value can be set a value 

within the range 1 to 32,767.

After the counter has counted up, 

the present value of the counter 

does not change, and the output 

contact stays in an operating 

state.

When reset input X001 turns ON, 

the present value of the counter 

returns to "0" and the counter 

contact also turns OFF.

Key operation

Monitor

mode

Operation

Output Y003

Present value of 

counter C0

Input X003 (count)

(reset)

0
1

2
3

4
5

6
7

8
9

10

Step Instruction

Monitor

/

Test

ON

Input X001 

( t)

0

3

7

9

X 001

X 003

Reset input

Count input

C    0

C0

RST C0

Y 003

K10

END

Reference

Let's try using monitor 
functions.

For example, 

a pedometer

input from 
Personal 
Computer

OUT   T0   K10,
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3.5 About Self-hold Circuits

Output operation can be held or cancelled by 

programming a self-hold sequence.

0

1

2

3

4

LD

OR

ANI

OUT

END

X 003

Y 003

X 004

Y 003

Y003 turns ON when X003 is 

ON and X004 is OFF.

Y003 continues to operate 

even if X003 is turned OFF. 

(This is "self-hold operation.") 

Y003 turns OFF when X004 is 

turned ON.

By the above program...

Circuit program List program

ON

ON

Input  X003

Output  Y003

ONInput  X004

X 003

Y 003

X 004

0 Y 003

Both of the following are the same self-hold circuit.
ReferenceReferenceReference

Step Instruction
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Starting with simple programs

Enough for theory, and now for practice
In this chapter, you study all about handling and operation such as programming 

and monitoring based on some simple examples.

PROGRAM TRAINING
Chapter 4



Escalator 

drive Y003
Pass detection switch: 1

      X003

Illumination 

lamp Y000

Passdetection switch: 0

            X001

S
o, this m

at acts

 like a sw
itch, 

right?
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4.1 Introductory Example 1 (Control of 

Escalators)

  I/O assignments
Input  Pass detection switch:0  X001

  Pass detection switch: 1  X003

Output Illumination lamp  Y000

  Escalator drive output  Y003

  Operation
(1)Let's assume that the escalator does not move until someone approaches it.

(2)When someone approaches the escalator and turns on pass detection switch: 

0, the illumination lamp lights and the escalator starts to move. (Escalator 

movement is up only.)

(3) The person is carried up by the escalator, and when that person moves off 

the escalator, pass detection switch: 1 turns ON, and the illumination lamp 

and escalator return to a non-operating state.

In this example, consider both pass detection switches: 0 and 1 as non-hold type 

switches.

Another assumption in this example is that people do not continue to get on this 

escalator.

Let's consider a PLC program for an escalator.
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The program is configured as follows

  Circuit program

  List program   Let's check operation 

Enter the above program on the PLC, and 

check program operation.

When input X001 is turned ON, outputs Y000 

and Y003 operate. Next, when input X003 is 

turned ON, outputs Y000 and Y003 become 

non-operational.

  Key operation
After preparing for programming (see page 3-3), create the program using the 

following key operations.

w 0 N O P

1 N O P

w 1 O R Y 0 0 0

1 N O P

w 5 E N D

6 N O P

Pass detection 

switch: 0

      X001

Pass detection 

switch: 1

X003
Illumination lamp ON

Escalator drive

Self hold 

   Y000

PLC power 

ON

Online 

selection

Y000

Y003

END

Writing the program

Read

Write 

Write All clear operation

Step Instruction

0

1

2

3

4

5

LD     X001

OR    Y000

ANI    X003

OUT   Y000

OUT   Y003

      END
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4.2 Introductory Example 2 (Control of Tea Dispenser)

Let's consider a PLC program for a tea dispenser

  I/O assignments 
Input Cup detection X000 (ON when cup is present)

 Dispense tea button X001

 Check tea leaves button X002

 Replenish water tank lower limit switch X003

 Replenish water tank upper limit switch X004

output Change tea leaves indicator lamp Y000

 Dispense tea output Y001

 Replenish water output Y003

  Explanation of operation
(1)When cup detection X000 is ON, and dispense tea button X001 is pressed 

(X001 turns ON), dispense tea output Y001 operates, and hot water is poured 

into the cup. Hot water is poured only for the duration that the button is 

pressed, and stops being poured when you release your hand from the 

button.

When cup detection X000 is OFF, hot water is not poured even by pressing 

dispense tea button X001.

(2)When water in the replenish water tank gets low, lower limit switch X003 turns 

ON and replenish water output Y003 operates.

    When replenish water output Y003 operates and water is poured into the tank, 

upper limit switch X004 finally turns ON, and replenish water output Y003 

becomes non-operational.

(3)When water is replenished five times, the change tea leaves indicator lamp 

lights.

(4)When the check button is pressed, the change tea leaves indicator lamp goes 

out.

Change tea leaves

Replenish water output

       Upper limit switch

       Lower limit switch

Cup detection

Dispense tea output

Dispense tea button

Y 003

Y 000

Dispense Check

Check tea
leaves

X 002

X 003

X 000

X 004

X 001

Y 001
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The program is configured as follows

  Circuit program

  Let's check operation
Enter the above program on the PLC, and 

check program operation.

(1)Output Y001 operates when both inputs 

X000 or X001 turns ON.

(2)When input X003 turns ON, output Y003 

operates, and when input X004 turns ON, 

output Y003 becomes non-operational.

(3)Each time that output Y003 operates, the 

value of counter C0 is incremented by one. 

When C0 reaches "5", Y000 operates.

(4)When input X002 turns ON, the value of 

counter C0 returns to "0" and output Y000 

becomes non-operational.

(Remarks)

With the FX-I/O demonstration training machine, 

the volume of the output Y001 buzzer can be 

adjusted. To raise the volume, turn the variable 

resistor on the top of the buzzer clockwise. To 

lower the volume, turn it counterclockwise.

  List program
Step Instruction

0

1

2

3

4

5

6

7

11

12

13

14

16

LD      X000

AND   X001

OUT   Y001

LD      X003

OR     Y003

ANI    X004

OUT   Y003

LD      Y003

 

  

LD       C0   

OUT    Y000

LD      X002

RST    C0   

      END

X 000 X 001

X 003 X 004

Y 003

X 002

Y 000

RST C0

C0

Y 001

END

C    0

Y 003

K 5

Y 003

Self hold

   Lower limit switch Upper limit switch

Dispense tea button
Dispense tea output

Replenish water output

Replenish water count

Change tea leaves indicator lamp

Counter reset

Cup detection

Replenish water output

Check button

input from 
Personal 
Computer

OUT   C0   K5,
OUT    C0   

SP       K5   

8
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4.3 Introductory Example 3 (Control of Drilling Machine)

Let's consider a PLC program for drilling on a drilling machine.

  I/O assignments
 Input Stop button X000

 Operation start button X001

 Fall start button X002 (Consider this to be an auto-return type pushbutton.)

 Fall end limit switch X003

 Rise end limit switch X004

output Drill rise output Y000

 Drill fall output Y001

 Drill rotation output Y003

  Explanation of operation
When operation start button X001 is pressed, drill rotation output Y003 operates 

and the drill starts to rotate.

When stop button X000 is pressed, drill rotation output Y003 becomes non-

operational, and drill operation stops.

If fall start button X002 is pressed during drill rotation, drill fall output Y001 

operates, and the drill starts to fall. When the drill finally reaches the position of 

the fall end limit switch, fall end limit switch X003 turns ON, and the drill fall 

operation stops.

Three seconds after the drill fall operation stops, drill rise output Y000 operates, 

and the drill rises.

The drill rise operation ends when rise end limit switch X004 turns ON after drill 

rise operation has begun.

Upper end limit switch

X 004

Y 000

Y 001

Y 003

X 003

X 002

X 000
X 001

Drill rise output

Drill fall output

Lower end limit switch

Fall start

button

Stop

button

Operation start

button

DOWN

STOP

RUN

Drill rotation output
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The program is configured as follows

  Circuit program

X 001 X 000

X 003

X 003

Y 001X 004

X 002

Y 003

Y 000

T0

Y 003

END

T    0

Y 003

Y 001

Y 000

K 30

Y 001

Self hold

Self hold

Fall start button Drill rotation

in progress

Fall end

limit switch

Interlock

Stop button

Self hold

Drill rotation

Drill fall

Drill rise

Operation start button

Fall end limit switch

Rise end

limit switch

Interlock

Y 000

  List program
Step Instruction

0

1

2

3

4

5

6

7

8

9

10

14

15

16

17

18

19

LD      X001

OR      X003

ANI     X000

OUT    Y003

LD       Y002

OR      Y001

AND   Y003

ANI     X003

ANI     Y000

OUT    Y001

LD       X003

LD      T0

OR      Y000

ANI    X004

ANI    Y001

OUT   Y000

END

input from 
Personal 
Computer

OUT   T0   K30,

  Let's check operation
Enter the above program on the PLC, 

and check program operation.

(1)When input X001 is turned ON, output 

Y003 operates. When input X000 

turns ON, output Y003 becomes non-

operational.

(2)If input X002 is turned ON while 

output Y003 is operating, output Y001 

operates. When input X003 is turned 

ON, output Y001 becomes non-

operational.

(3)If input X003 is held in an ON state, 

timer T0 starts to count. After three 

seconds, the T0 contact turns ON.

(4)When timer T0 turns ON, output Y000 

operates. When input X004 turns ON, 

output Y000 becomes non-

operational.

OUT    T0

SP        K30 

11
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4.4 Introductory Example 4 (Control of Quiz Answer Display Panel)

Let's try considering a sequence program for a quiz program.

  I/O assignments 
Input Children's buttons X000   X001   output Children's lamp Y000

 Adult's buttons X002   X003                  Adult's lamp Y001

 MC's button X004                             Jackpot ball open button Y004 

Lucky chance switch X005

  Explanation of operation
(1) Light the lamp that is the quickest to respond to the MC's question. 

(2) The lamp lights until the MC presses pushbutton X004. Note, that the 

children's team has an advantage as lamp Y000 can be made to light 

whichever of pushbuttons X000 and X001 is pressed.

The adults' team have a disadvantage as lamp Y001 does not light unless 

both pushbuttons X002 and X003 are pressed.

(3) When the MC has turned lucky chance switch X005 ON, the children have a 

lucky chance to open the jackpot ball if they press the button within ten 

seconds.

Jackpot ball

Pushbutton

switch

MC

Pushbutton

switch

Lamp
Lamp

Children

Lucky chance

switch

Adults

X 000 X 001 X 002 X 003
Y 000

Y 001

X 005

X 004

SW

PB4

SOL  Y 004
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The program is configured as follows

  Circuit program

  Let's check operation
Enter the above program on the PLC, 

and check program operation.

(1)When X000 or X001 turns ON, 

output Y000 operates and holds its 

own state. Note, however, that 

Y000 does not turn ON if Y001 

turned ON first.

(2)Operation of Y001 is the same 

except that when     X004 turns 

OFF, the self hold is canceled 

(reset).

(3)When lucky chance input X005 

turns ON, jackpot ball open output 

Y005 also holds its own state by 

Y000 turning ON.

Note, however, that this operation 

is not performed when      T0 is 

OFF. When X005 turns ON, timer 

T0 starts to operate, and the output 

contact operates ten seconds later.

X 000

X 001

X 004

X 004

Y 000 X 005

X 005

X 002

Y 000

Y 001

Y 004

T    0

X 003

Y 001

Y 000

Adults

Children

Lucky chance

MC Children

MC Adults

Children

Children

Children

Adults Adults

Children's lamp

Adults' lamp

Open jackpot ball
Lucky chance

END

K 100

Y 001

T0

Y 000

Y 004

Step Instruction

0

1

2

3

4

5

6

7

8

9

Step Instruction

10

11

12

13

14

15

16

17

18

19

20

  List program
Let's try considering the program.
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Let's use a personal computer to create the programs!

Appendix 1
THE OPERATION OF THE GX Developer

Using a personal computer, sequence becomes easier   
If a personal computer software GX Developer is used to create and edit the sequence 
program, it becomes easier just like illustration making.
If the basic operations are mastered, it is just the repetition of them.
There are many functions easy to use in the software. Let’s master them sequentially 
starting from the necessary operations.

Smoothly starting up and adjusting   
The program is accompanied by the debug.
The operation status of the PLC and program can be monitored on the personal 
computer screen, so if some parts are not working as planned, confi rmation and 
adjustment can be conducted at once.

Make the program easy to read   
There is a "comment input function" in GX Developer to make the sequence program 
easy to read.
It can improve the effi ciency to create and debug the program if a comment is input.
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Appendix 1.1 Basic knowledge for operating GX Developer
Appendix 1.1.1 Construction of the GX Developer’s screen

Title bar
The name of the opened project and the operation icon of windows are displayed.
1)

    1) Title bar

   6) Status bar

  2) Menu bar

   3) Tool bar

5) Edit screen

    4) Project data list

Changing the size of GX Developer and quitting it Maximizing and restoring down GX Developer

Quitting GX DeveloperMinimizing GX DeveloperDisplay of the project 
name and its path

    1) Title bar

   6) Status bar

  2) Menu bar

   3) Tool bar

5) Edit screen

    4) Project data list
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Menu bar2)

Drop down menu will be displayed after menu is selected.

Tool bar3)

*:  The contents of the tool bar can be moved, added and removed, therefore the displayed items and 
the layouts depend on the various environments.

Project data list4)

Circuit creating window, parameter setting screen and so on are displayed by tree structure.

The description 
of the function 
will be displayed 
when the mouse 
cursor stops at 
the buttons.

Directly specify the items 
displayed by mouse clicking.

The frequently used functions are confi gured by icon buttons. Compared to selecting from the menu, 
the desired function can be directly executed.
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Edit screen5)

Status bar
The status of the operation and setting is displayed.
6)

5) Edit screen

Scroll Lock status

The instruction of the 
mouse cursor position

CPU
type

The location of the 
CPU connected

Caps Lock
 status

Num Lock 
status

Current input mode is displayed

Circuit creating screen, monitor screen and so on are multiply displayed by windows.
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Appendix 1.1.2 About the "Project"

"Project" consists of Program, Comment, Parameter and Device Memory.
An aggregate of a series of data in GX Developer is called "Project", and stored as a folded of 
Windows®.

Editing multiple projects

Start multiple GX Developer when more than one projects are to be edited.

●

Project

Program

Comment

Parameter

Device Memory

This is equivalent to the of Windows®.

Sequence program

Comment on the devices

Parameter setting data of PLC

Contents of the current device value, or the input device value

folder
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Appendix 1.2 Starting GX Developer and creating a new project
Appendix 1.2.1 Starting GX Developer

Start from the Start  button of Windows, and 
select in the following order.
[Programs]
             ↓
[MELSOFT Application]
             ↓
[GX Developer]

1)

GX Developer is started.2)
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Select  from the tool bar, or select [Project] 
→ [New project] ( Ctrl  + N ) from the menu.
Click the [▼] button of [PLC series].

1)

2)

Appendix 1.2.2 Creating a new project

Select "FXCPU".
Click the [▼] button of [PLC type].

3)
4)

Select "FX3U(C)".
Note: Select the series name that is actually 

used.

5)

1) Click

1) Click

 3) Click and select

2) Click

 5) Click and select

4) Click
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Click OK .6)

New project screen is displayed and the 
project can be input.

7)

About the parameter setting
In FX PLC, it is not necessary to set the parameters when the comments stored in PLC are not 
set or fi le registers are not used.
For the details of the parameters, see Appendix.

●

Point

6) Click

7) New project screen
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Appendix 1.3 Creating a circuit
Appendix 1.3.1 Creating a circuit by using the function keys

[The circuit to be created]

X002
Y000

Y000

X000

X003
Y001

The relationship between the function keys and the symbols of the circuit is displayed on the 
buttons of the tool bar.

                                                                          Main key operations

When creating a circuit, make sure to set to "Write Mode".

Select from the tool bar. Select from the menu  ([Edit] → [Write mode]).

Use half-width characters when inputting. Full-width characters are not allowed.

●

●

●

Point

F5 F6 F7

F8

F9

F5

Shift Shift

F6

Shift

F9

Ctrl

F10

F9

Ctrl

＋ ＋ ＋ ＋

＋

In this book, the number of the input 
relay and output relay is displayed 
as "X000", "Y000" by three digits.
"X0", "Y1" and the "0" on the left 
front can be omitted when the input 
is performed from GX Developer.

Point
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Press the F5   key.
Input "X2".

1)

The circuit input 
X0

 is displayed.
Press the F7   key.
Input "Y0".
Confi rm it by the Enter  key or [OK].

6)
7)

8)

The circuit input  is displayed.
   Press the Shift  + F5   key.
Input "Y0".

  Confi rm it by the Enter  key or [OK].

9)
10)

11)

The circuit input 
X2

 is displayed.
Press the F6   key.
Input "X0".
Confi rm it by the Enter  key or [OK].

3)
4)

5)

Cancel it by ESC  or 
[Cancel].

Confi rm it by the Enter  key or [OK].2)

1) Input "X2"   2) Input the Enter  key

4) Input "X0"

3) The circuit is displayed

  5) Input the  Enter  key

6) The circuit is displayed

7) Input "Y0"   8) Input the  Enter  key

9) The circuit is displayed

  11) Input the  Enter  key10) Input "Y0"
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  The circuit input 
Y0

 is displayed.
   Move the cursor to the beginning of the next 
line.

   Press the F5   key.
Input "X3".

   Confi rm it by the Enter  key or [OK].

12)
13)

14)

15)

  The circuit input 
X3

 is displayed.
   Press the F7   key.
Input "Y1".

  Confi rm it by the Enter  key or [OK].

16)
17)

18)

   The circuit input  is displayed.
!!The circuit is created!!

19)

12) The circuit is displayed

13) Move the cursor

  15) Input the  Enter  key14) Input "X3"

17) Input "Y1"

16) The circuit is displayed

  18) Input the  Enter  key

19) The circuit is displayed

F4  (Convert)

20) The grey display disappears

   Circuit-Conversion Operation [Important]
Do the "Conversion" operation to confi rm the 
circuit diagram that is not confi rmed (the grey 
displayed part).

Press the F4  (Convert) key.
Or select  from the tool bar, or select 
[Convert] → [Convert] from the menu.

20)

The grey display disappears and the circuit is 
confi rmed.
If an error occurs, the cursor moves to the failure 
part of the created circuit. Correct the circuit.
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Appendix 1.3.2 Creating a circuit by using the tool buttons

[The circuit to be created]

Click the tool buttons to input the symbols of the circuit.

                                                                              Main tool buttons

When creating a circuit, make sure to set to "Write Mode".

Select from the tool bar. Select from the menu ([Edit] → [Write mode]).

Use half-width characters when inputting. Full-width characters are not allowed.

●

●

●

Point

X002
Y000

Y000

X000

X003
Y001

In this book, the number of the input 
relay and output relay is displayed 
as "X000", "Y000" by three digits.
"X0", "Y1" and the "0" in the left front 
can be omitted when the input is 
performed from GX Developer. 

Point
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The circuit input 
X0

 is displayed.
Click the tool button .
Input "Y0".
Confi rm it by the Enter  key or [OK].

6)
7)

8)

The circuit input  is displayed.
   Click the tool button  .
Input "Y0".

  Confi rm it by the Enter  key or [OK].

9)
10)

11)

Cancel it by ESC  
or [Cancel].

The circuit input 
X2

 is displayed.
Press the tool button  .
Input "X0".
Confi rm it by the Enter  key or [OK].

3)
4)

5)

Confi rm it by the Enter  key or [OK].2)

Click the tool button .
Input "X2".

1)

2) Click1) Input "X2"

5) Click4) Input "X0"

3) The circuit is displayed

8) Click7) Input “Y0”

6) The circuit is displayed

11) Click10) Input “Y0”

9) The circuit is displayed
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  The circuit input 
Y0

 is displayed.
   Move the cursor to the beginning of the next 
line.

   Click the tool button .
Input "X3".

  Confi rm it by the Enter  key or [OK].

12)
13)

14)

15)

  The circuit input 
X3

 is displayed.
   Click the tool button  .
Input "Y1".

  Confi rm it by the Enter  key or [OK].

16)
17)

18)

   The circuit input  is displayed.
!!The circuit is created!!

19)

13) Move the cursor

12) The circuit is displayed

15) Click14) Input "X3"

18) Click17) Input "Y1"

16) The circuit is displayed

19) The circuit is displayed

F4 (Convert)

20) The grey display disappears

   Circuit-Conversion Operation [Important]
Do the "Conversion" operation to confi rm the 
circuit diagram that is not confi rmed (grey 
display part).

Press the F4  (Convert) key.
Or select  from the tool bar, or select 
[Convert] → [Convert] from the menu.

20)

The grey display disappears and the circuit is 
confi rmed.
If an error occurs, the cursor moves to the failure 
part of the created circuit. Correct the circuit.
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Appendix 1.4 Writing programs to PLC
Write the created sequence program to FX PLC.

Appendix 1.4.1 Connecting PC to PLC

Example for connection (Personal computer side: RS-232C)1)

Example for connection (Personal computer side: USB)2)

Check the COM port number that the driver of FX-USB-AW assigns to the 

personal computer. For the check procedures, see the manual of FX-USB-

AW.

●

FX3U-48MR/ES
FX3U-48MFX3U

ERROR

RUN

BATT

POWER

R

0 31 2
IN

OUT

64 5 217 20 2422 23 2625

10 11 1312 1614 15 17

27

0 31 2 64 5 217 20 2422 23 2625

10 11 1312 1614 15 17

27

Y12Y10 Y16Y14 Y22Y20 Y26 COM5
COM1

Y24Y6Y4Y2Y0
Y7 Y11 Y13Y5COM2Y3Y1 COM3 Y15 Y17COM4 Y23 Y25 Y27Y21

X5
X0

X1
X2

X3 X7 X11 X13
X40VS/S

N 24V
X6 X10 X12 X14 X16 X20

L X27X23 X25X15 X17 X21
X24 X26X22

FX3U-48MR/ES
FX3U-48MFX3U

ERROR

RUN

BATT

POWER

R

0 31 2
IN

OUT

64 5 217 20 2422 23 2625

10 11 1312 1614 15 17

27

0 31 2 64 5 217 20 2422 23 2625

10 11 1312 1614 15 17

27

Y12Y10 Y16Y14 Y22Y20 Y26 COM5
COM1

Y24Y6Y4Y2Y0
Y7 Y11 Y13Y5COM2Y3Y1 COM3 Y15 Y17COM4 Y23 Y25 Y27Y21

X5
X0

X1
X2

X3 X7 X11 X13
X40VS/S

N 24V
X6 X10 X12 X14 X16 X20

L X27X23 X25X15 X17 X21
X24 X26X22

PLC
built-in port
(RS-422)

FX-422CAB0

RS-232C

F2-232CAB-1

FX-232AWC-H
(RS-232C/RS-422 converter)

GX Developer

FX3U-48MR/ES
FX3U-48MFX3U

ERROR

RUN

BATT

POWER

R

0 31 2
IN

OUT

64 5 217 20 2422 23 2625

10 11 1312 1614 15 17

27

0 31 2 64 5 217 20 2422 23 2625

10 11 1312 1614 15 17

27

Y12Y10 Y16Y14 Y22Y20 Y26 COM5
COM1

Y24Y6Y4Y2Y0
Y7 Y11 Y13Y5COM2Y3Y1 COM3 Y15 Y17COM4 Y23 Y25 Y27Y21

X5
X0

X1
X2
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Transparent function of GOT1000 (Personal computer side: USB)3)
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Appendix 1.4.2 "Transfer Setup" in GX Developer

Confi gure the settings of GX Developer to communicate with PLC.

Select [Online] → [Transfer Setup].
Double-click the icon .

1)
2)

Set the communication port of personal 
computer side.
(a)  Select "RS-232" when RS-232 connector is 

used at personal computer side or FX-USB-AW 
is used with the USB connector at personal 
computer side.

(b)  Select "USB (GOT transparent mode)" when 
the transparent function of GT1000 is used with 
the USB connector at personal computer side.

(c) ·  When RS-232C connector is used at personal 
computer side, the port is usually COM1.
 (It may change depending on personal 
computers.)

     ·  Specify the COM port number that the driver 
assigns when using FX-USB-AW. (See 
Section 3.7.1)

3)

Click [OK] after the setting is completed.
Click [Connection test], to check the 
communication with PLC.
After checking, click [OK] to confi rm the 
setting confi gured.

4)
5)

6)

1) Transfer Setup is displayed

2) Double-click

3) (a)

3) (b)

3) (c)

4) Click

5) Click

6) Click
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Appendix 1.4.3 Writing a program to the PLC

Set the "RUN/STOP" switch of PLC to 
"STOP".

1)

[Online] → [Write to PLC] from the menu.
Click [Param + Prog].3)

 Select  from the tool bar or select 2)

Click [Execute].4)
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1) Set to "STOP"

2) Click

4) Click

3) Select the data
    to be written

5) Click

The dialog box of the progressing rate is 
displayed.
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Appendix 1.4.4 Operation monitor of the program

Set the "RUN / STOP" switch of PLC to 
"RUN".

1)

Operation check by operation monitor

Set [Switch X002 is "ON"] with the status [Switch X000 is "OFF"], and then check [Output Y000 is 
"ON"].
Check [Output Y000 is "ON"] while [Switch X002 is "OFF"].
Set [Switch X000 is "ON"] and then check [Output Y000 is "OFF"].
Check [Output Y001 is "ON/OFF"] in accordance with [Switch X003 is "ON/OFF"].

1)

2)
3)
4)
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1) Set to "RUN"

 2) Click

Select  from the tool bar or select [Online] 
→ [Monitor] → [Monitor mode] from the menu.

2)
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(1) The display of the monitor status dialog

4)3)2)1)

(2) The interpretation of the status display for the circuit monitor 

Reference

Scan time
The maximum scan time of the sequence 
program is displayed.
PLC status
The status of the PLC is displayed.
The execution status of the monitor
It is fl ashing when the monitor is being 
executed.
Memory type display
The memory type of the PLC is displayed.

1)

2)

3)

4)

Contact Instruction
Input contact

Type X0: OFF X0: ON

NO contact
X000

Circuit open

X000

Circuit close

NC contact
X000

Circuit close

X000

Circuit open

1)

Out Instruction
Driving status

Type
Non-execution/

Non-drive Execution/Drive

OUT instruction

Y000 Y000

SET instruction, 
etc.

SET M0 SET M0

2)

The ON/OFF status of the device to be rest is displayed by the monitor using RST instruction. 

Device status
Type

When device to be 
reset is OFF

When device to be 
reset is ON

RST instruction
RST M0 RST M0



71

Appendix 1.5 Editing the circuit
Appendix 1.5.1 Correcting the circuit

Make sure to set to "Write Mode" when amending the circuit.
Select from the tool bar. Select from the menu ([Edit]→[Write mode]).

Use half-width characters when inputting. Full-width characters are not allowed.

Switch between "Ovrwrte" and "Insert"
• Set to "Ovrwrte" when correcting the already created circuit diagram.
• The new circuit will be inserted when the "Insert" mode is set to.

●

●

●

Point

 It switches between
"Ovrwrte" and "Insert"
by pressing the             key.Insert
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1) Changing the number of the OUT coils and the contacts

[The circuit to be corrected]

Confi rm it by the Enter  key or [OK].
The corrected result is displayed and the 
circuit block is displayed in grey.

3)
4)

Double-click the part need to be corrected.1)

Confi rm the changes by pressing the F4  
(Convert) key.

5)

X002

Y000

X000

X003
Y001

Y002

Y000

Change to

Change "Y001" to "Y002".2)

1) Double-click

2) Change "Y002"   3) Input the  Enter  key

F4 (Convert)

4) The corrected result is displayed
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2) Adding lines

[The circuit where lines are to be added to]

The line reaching the dropped position is 
added.
Locate the cursor on the position where the 
OUT coil is to be added to and click  on the 
tool bar.

3)

4)

Click  ( F10 ) on the tool bar. 1)

X002

Y000

X000

X003
Y001

Y000

Y003

Add the vertical/
horizontal lines and
create the OUT coil

Locate the cursor on the upper right of the 
desired vertical line to be added, and then 
drag it until it reaches the desired position, and 
then drop it.

2)

Input "Y3".
Confi rm it by the Enter  key or [OK].

5)
6)

1) Click

2) Drag

Locate the cursor on the upper right of the 
beginning of the vertical chart to be added

5) Change "Y003"   6) Input the  Enter  key

The lines are added

4) The position of the cursor
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Confi rm the changes by pressing the F4  
(Convert) key

•  Click  on the tool bar again to fi nish the 
operation.

8)

The circuit adding is fi nished and the circuit 
block is displayed in grey.

7)
7) The circuit adding
     is completed

F4 (Convert)
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3) Deleting lines

[The circuit where lines are to be deleted]

The lines are deleted.
Delete the OUT coil by the Delete  key.

3)
4)

Click  Alt  + F9  on the tool bar.1)

X002

Y000

X000

X003
Y001

Delete this
circuit

Y000

Y003

Locate the cursor on the upper right of the 
desired vertical line to be deleted, and then 
drag it until it reaches the desired position, and 
then drop it.

2)

1) Click

2) Drag

Locate the cursor on the upper right 
of vertical line to be deleted

3) Delete the lines

4) Delete it by the  Delete  key
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The deleted circuit block is displayed in grey.5)

Confi rm the changes by pressing the F4  
(Convert) key.

• Click  on the tool bar again to fi nish the 
operation.

6)

F4 (Convert)
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Appendix 1.5.2 Inserting and deleting lines

1) Adding lines

[The circuit where a line is to be inserted into]

The line is inserted.3)

X002

Y000

X000

X003
Y001

Add this lineX001

Y000

Y002

Right click the mouse at any place, and select 
[Insert line].

2)

A line is inserted above the line where the cursor 
is located

Locate the cursor on the line below the one to 
be inserted.

1)

Add a program in the inserted line.4)

Confi rm the changes by pressing the Convert  
(F4) key.

5)

   1) Move the cursor to the line 
       below the one to be inserted

Select "Insert line"

2)
Right click 
the mouse

3) New line is inserted

4) Add a circuit
X001

Y002
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2) Deleting lines

[ The circuit where a line is to be deleted ]

The line is deleted3)

Move to the line to be deleted1)

X002

Y000

X000

X003
Y001

Delete this line

X001

Y000

Y002

Right click the mouse at any place, and select 
[Delete line]

2)

The line to be deleted is displayed in grey. 
Confi rm it by pressing Convert  (F4).

Point

1) Move the cursor to 
    the line to be deleted

Select "Delete line"

2)
Right click 
the mouse

3) The line is deleted
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Appendix 1.5.3 Cutting and copying (pasting) the circuit

1) Cut

[The circuit to be edited]

Move the cursor to the beginning of the circuit 
to be cut.

1)

X002

Y002

X000

X004
Y004

X007

Y002

Y007
Cut this line

Drag it until it reaches the desired position, 
and then drop it.
Select  from the tool bar or select [Edit] → 
[Cut] ( Ctrl  + X ) from the menu, and execute 
the cut.

2)

3)

The selected area is cut
The grey displayed part is remained when one 
part of the circuit is cut. Confi rm it by the F4

(Convert) key after the circuit is amended.

4)

The cut and copy area1) Move the cursor to 
    the beginning of the 
    cut area

2) Drag it until it reaches the desired 
position, and then drop it

3) Execute cut

4) The selected 
    area is cut
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Continue to edit the circuit with the "cut" operation 
performed in the previous steps.

Move the cursor to the beginning of circuit to 
be copied.

1)

Drag it until it reaches the desired position, 
and then drop it.
Select  from the tool bar or select [Edit] → 
[Copy] ( Ctrl  + C ) from the menu.

2)

3)

Select  from the tool bar or select [Edit] → 
[Paste] ( Ctrl  + V ) from the menu.

The grey displayed part is remained when one part of 
the circuit is pasted. Confi rm it by the F4  (Convert) key 
after the circuit is amended.

5)

Move the cursor to the position where to 
paste.

4)

Switch by the Insert  key
"Ovrwrte" mode : Pastes by overwriting in 
the cursor position.
"Insert" mode : Pastes by inserting in the 
cursor position.

Point

����� �����

1) Move the cursor to the
    beginning of the copy area

3) Execute
    copy

2) Drag it until it reaches the desired 
    position, and then drop it.

4) Move the cursor to the
    position where to copy

5) Finish copy/paste

Y000

X004

X000

X002
Y000

X002
Y000

Y000

X000

Y004

Copy this
line

Paste it to
this line
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Appendix 1.6 Saving the created circuit
Appendix 1.6.1 Save as and save

If there are circuits not converted in the program, press Convert  (F4) and save it.
Point

Select  from the tool bar or select [Project] 
→ [Save] ( Ctrl  + S ) from the menu.

1)

Click Yes  in the conformation dialog and 
fi nish it.

 
If there is not suffi cient space in the fl oppy disk to 
save the project, temporarily save it to the hard 
disk and then move it to the other fl oppy disk.

6)

Specify the storage destination for the project.
Specify the project name.
Specify the title describing the project 
(optional).
Click Save .

2)
3)
4)

5)

Reference

1) Click

3) Specify the project name

2) Specify the storage 
destination for the project

5) Click

4) Specify the title (optional)

6) Click

(When it is newly saved)

(When it is saved by overwriting)

Project saving is fi nished

The following characters cannot be used in the project name.
/ ,¥ ,> ,< ,* ,? ,” ,“ , | , : , ; ( ; ,  ¥ are only used to specify the driver)
Also, do not use “.” (period) at the end of the project name.

When the project name is specifi ed with 8 or more characters by GX Developer (later than SW6D5-
GPPW), characters past the 8th character will not be displayed if read by the old versions (older than 
SW2D5-GPPW) of GX Developer.

The project path plus its name is within 150 half-width characters (75 full-width characters). 

The tile is within 32 half-width characters (16 full-width characters).

If there are spaces in the project path and project name, GX Developer cannot start normally even if 
GPPW.gpj, ***.gps is double-clicked in the Explorer window.
If there are spaces in the project path and project name, open the project by starting GX Developer → 
selecting [Project] → [Open project] from the menu.

●

●

●

●

●
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Appendix 1.6.2 Saving the project as a new one

Select [Project] → [Save as] from the menu.1)

Specify the storage destination for the project.
Specify the project name.
Specify the title describing the project 
(optional).
Click Save .

2)
3)
4)

5)

Click Yes  in the confi rmation dialog and 
fi nish it.

6)

For the way to name the driver/path and the project, 
see the previous page.
 
If there is not suffi cient space in the fl oppy disk to 
save the project, temporarily save it to the hard 
disk and then move it to the other fl oppy disk.

If there are circuits not converted in the program, press Convert  (F4) and save it.

Point

1) Click

3) Specify the project name

2) Specify the storage 
destination for the project

5) Click

4) Specify the title (optional)

6) Click
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Appendix 1.6.3 Reading the project

Select  from the tool bar or select [Project] 
→ [Open project] ( Ctrl  + O ) from the menu.

1)

If another project is open at the reading operation, the project is closed.
If there are circuits not converted in the project or the project is not saved, the warning message is 
displayed.

Reference

Select the storage destination of the project.
Select the project to be read.
Click Open  and read the project.

2)
3)
4)

1) Click

3) Select the project name

4) Click

2) Select the storage 
destination of the project.
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Appendix 1.7 Necessary operation for the debug of the program
For connecting to PLC and the writing of the program, see "3.4Writing programs to PLC".

Appendix 1.7.1 Circuit monitor
Display the circuit, and monitor the conduction status of the contacts and the driving status of the coils

The ON/OFF status of the circuit and the 
current value of the word device (timer, 
counter and data register) are displayed in the 
circuit monitor window.
Right click the window, select [Stop monitor] to 
quit the circuit monitor.
In order to correct and write the program, 
select  from the tool bar or select [Edit] → 
[Write mode] from the menu.

2)

3)

4)

Select  from the tool bar or select [Online] 
→ [Monitor] → [Monitor mode] from the menu.

1)
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(1) the display of the monitor status dialog

4)3)2)1)

(2) The interpretation of the status display for the circuit monitor

Reference

Scan time
The maximum scan time of the sequence 
program is displayed.
PLC status
The status of the PLC is displayed.
The execution status of the monitor
It is fl ashing when the monitor is being 
executed.
Memory type display
The memory type of the PLC is displayed.

1)

2)

3)

4)

Contact Instruction
Input contact

Type X0: OFF X0: ON

NO contact
X000

Circuit open

X000

Circuit close

NC contact
X000

Circuit close

X000

Circuit open

1)

Out Instruction
Driving status

Type
Non-execution/

Non-drive Execution/Drive

OUT instruction

Y000 Y000

SET instruction, 
etc.

SET M0 SET M0

2)

The ON/OFF status of the device to be reset is displayed by the monitor using RST instruction. 

Device status
Type

When device to be 
reset is OFF

When device to be 
reset is ON

RST instruction
RST M0 RST M0
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Appendix 1.7.2 Device registration monitor

1) Registering optional devices
Register the optional devices in the monitor window and monitor the necessary part only.

Input the device number to be registered in the 
Register device window.

Click [Register].

4)

5)

The device is registered in the monitor 
window.

Click [Start monitor], and the value showing 
the device action and the ON/OFF status of 
the contacts and coils are displayed.

6)

7)

Set the circuit monitor status. (See Section 
3.7.1.)

Select [Monitor] → [Entry data monitor] from 
the menu. Or right click the circuit window and 
select [Entry data monitor]. 

1)

2)

3) Click

Select "32 bit integer" 
when you want to 
nomitorthe device in 
32 bits. 

4) Input the device

5) Click

7) Click

Click [Register devices] in the "Entry data 
monitor" window.

3)
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Set to the status of the circuit monitor. (See 
Section to 3.7.1.)

Select [Monitor] → [Entry data monitor] from 
the menu. Or right click the circuit window and 
select [Entry data monitor]. (See the previous 
page)

Select [Window] → [Tile horizontally] from 
the menu to display the "Circuit window" 
and "Entry data monitor window" apposed 
together. (Set "Entry data monitor window" to 
the status of stop monitoring.)

The "Circuit window" and "Entry data monitor 
window" are displayed horizontally.

1)

2)

3)

4)

2) Registering the devices displayed in the circuit monitor
Specify the area of the circuit diagram in the circuit monitor window and register all of the devices in the 
area.

5) Click the start point of the circuit.

6) Click the end point while pressing
    [Shift] key to select the area.

7) Click

The devices are registered to the monitor 
window.

Click [Start monitor], and the value showing 
the device action and the ON/OFF status of 
the contacts and coils are displayed.

8)

9)

9) Click

Click the start point of the circuit.

Click the end point while pressing the [Shift] 
key to select the area.

Drag the selected area to the "Entry data 
monitor window".

5)

6)

7)
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Appendix 1.7.3 Device batch monitor
Specify the start number and monitor the continuous devices.

Set to the status of the circuit monitor. (See 
Section 3.7.1.)

Select [Monitor] → [Device batch] from the 
menu. Or right click the circuit window and 
select [Device bath].

1)

2)

3) Input the device

The value showing the device action and the 
ON/OFF status of the contacts and coils are 
displayed.

4)

Input the start number of the devices to be 
monitored in the "Device batch monitor" 
window and then press the Enter  key, and 
then click [Start monitor].

3)
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Appendix 1.7.4 Device test

1) Forced ON/OFF
Forcedly turn ON/OFF the bit devices of PLC (M,Y,T,C and so on). (The forced ON/OFF function of X is 
not available.)
When PLC is running, the forced ON/OFF function can turn on or off the devices only for one scan and 
the operations according to the sequence program are given priority.  When checking the output, set 
PLC to the STOP status.

Set to the status of the circuit monitor. (See 
Section  3.7.1.)

Select [Monitor] → [Device] → [Device test] 
from the menu. Or right click the circuit 
window and select [Device test].

1)

2)

Forced ON/OFF (Circuit monitor window)
The specifi ed device can be forcedly turned on/off by double-clicking any bit device (contact, coil) in 
[Circuit monitor window] while pressing the [Shift] key.

Reference

3) Input the device

4) Click

Input the device number to be forcedly turned 
on/off.

• [FORCE ON]: Turns on the device.
• [FORCE OFF]: Turns off the device.
•  [Toggle force]: Switches the ON/OFF status 

of the device is switched each time it is 
pressed.

3)

4)
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2) Changing the current value of the word device
Change the current specifi ed value of the PLC's word device (T, C, D and so on).

Set to the status of the circuit monitor. (See 
Section 3.7.1.)

Select [Monitor] → [Debug] → [Device test] 
from the menu. Or right click the circuit 
window and select [Device test].

1)

2)

3) Input the device

5) Click   4) New value

Input the device number to be changed.

Input the a new value.

Click [Set].

3)

4)

5)
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Appendix 1.7.5 Writing the program during RUN
Write the corrected part of the circuit to PLC when the PLC is running.
Less time is needed for the writing because of not transferring the entire program.

Adding the contact to the circuit on the left is 
described as an example.
Display the circuit diagram and set it to write 
mode (  ).

1)

It is impossible to write the program to PLC if the program before corrected in PLC is different from 
the one in GX Developer. Verify it in advance, or transfer it by [Write to PLC] if not knowing whether 
they are the same.

Caution

Add the contact.
The circuit block is displayed in grey.

2)

Pressing [Shift] and [F4] together, or select 
[Convert] → [Convert (Write during RUN)] 
from the menu.

3)

The message "RUN write processing has 
completed." is displayed and click [OK].

5)

2) Add the contact

4) Click

5) Click

Write during RUN  Shift+F4

Click [Yes] to confi rm the warning message 
about confi rming the safety of the PLC 
controlling changes due to the program 
changes

4)
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Appendix 1.8 Inputting comment
Appendix 1.8.1 Types of the comment
The following 3 types of the comments can be input.

Type Purpose
The number of 
the characters 
(full-width)

Remark

1) Device comment The comment describing the role 
and function of each device 16

It is necessary to set "Comment 
capacity setting" for the parameter 
when writing to PLC. "Comment range 
setting" for the writing also needs to be 
set.

2) Statement The comment describing the role 
and function of the circuit blocks 32

It is only the comment (peripheral) in 
the GX Developer’s side. (It is not put in 
PLC)

3) Note
The comment describing the 
role and function of the output 
instructions

16
It is only the comment (peripheral) in 
the GX Developer’s side. (It is not put in 
PLC)

[Comment Examples]

How to display the comment

Select [Display] → [Display comment] from the menu and then the comments are displayed.

Do the above operation again to stop comment displaying

●

●

Point

T5 NO contact exists at step10,
whereas T5 NC contact exists at step8.

3) Note

2) Statement

1) Comment

X000

Y000

Y000

T5

T7

Start

Lamp
Green

Conveyor
Stop
Time

START Circuit

Buzzer Time Setting

Lamp Green

2-second Timer

0

4

8

<The Start Btn truns on lamp   >

<Buzzer rings awhile                 >

(Y000   )
Y000
A/S
A/S

1

T5
B/D
B/D

10
8

4
Lamp
Green

K20

(Y001   )
Buzzer

T5
2-second
Timer
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Appendix 1.8.2 Operation for creating the device comment

1) How to input the device comment from the list

Click [Device comment] → [COMMENT] in the 
project list.

1)

1) Click

Input the start number of the devices which 
are to be commented in "Device name", and 
click [Display].

Input comments in the "Comment" column.

•  When inputting comments for another 
device, Input the device number again 
following step 2.

2)

3)

2) Input the device number

3) Input comments

Click  from the tool bar and double-click the 
circuit diagram symbol to be commented.

Input the comment in the "Enter symbol" 
window and click [OK].

•  Click  on the tool bar again to fi nish the 
operation. 

1)

2)

2) How to input the device comment from the circuit diagram

1) Double-click

2) Input the comment
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How to input comments when creating a circuit
Reference

Continues during command write

Setting for writing the device comments to PLC
It is necessary to set "Parameter setting" and "Comment range setting" to write the device comments 
to PLC.

Parameter setting
Select [Parameter] → [PLC parameter].

Set the "number of blocks" in the "Comment capacity" setting.
One block is equivalent to a 50-point comment, occupying the capacity of 500-step program 
memory.

The capacity of the program
reduces according to the
reduction of the comment capacity.

Comment capacity setting

2) Comment range setting
Select [Device comment] → [Comment], and then the comment input screen is displayed.

Select [Edit] → [Setup comment range] from the menu.

Set the type and the range of the devices to be written to PLC in the Setup comment rang 
dialog.

Comment
range setting

1)
●

●

●

●

●

Point

Select [Tool] → [Options] from the menu, Check 
"Continues during command write" of the 
[Comment input] box in the [Program common] 
tab.
After configuring the settings as above, the 
operation of the circuit input continues and the 
"Enter symbol" window described in step 2) is 
displayed, when the circuit is being created.
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Appendix 1.8.3 Operation for creating the statement

Click  from the tool bar, and double-click 
anywhere of the circuit block which the 
statement is to be written to.

Input the statement in the "Enter line 
statements" window and click [OK].

•  Click  on the tool bar again to fi nish the 
operation.

1)

2)

Appendix 1.8.4 Operation for creating the note
Click  from the tool bar, and double-click 
the output instruction symbol which the note is 
to be written to.

Input the note in the "Enter Note" window and 
click [OK].

•  Click  on the tool bar again to fi nish the 
operation.

1)

2)

1) Double-click

2) Input the statement

2) Input the note

1) Double-click
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Appendix 1.9 Operation for creating the program list
In GX Developer, the program can also be created by list.

Appendix 1.9.1 Displaying the list edit screen

Create a new project (See Section 3.2.2.) or 
display the circuit of the existing project.

Select  from the tool bar or select [View] → 
[List display] from the menu.

1)

2)

Appendix 1.9.2 How to input instructions

Input the instruction language from step 0 
sequentially.
The step number is added automatically when 
instruction is input. (For the input procedures, 
see the next page.)

1)

1) The list edit screen is displayed

3) The list edit screen
     is displayed

Initial screen           After list input

The list edit screen is displayed.
Click  on the tool bar again or select [View] 
→ [Circuit display] from the menu to return to 
the circuit display.

3)



97

How to input the basic instructions and the applied instructions
A "space" is input between the instruction language, device number and operand.

●

[Examples for the basic instructions]
LD 
OUT
LDI
AND
OUT
LD
OUT
OUT

[Examples for the applied instructions]
MOV
CMP

Connection and OUT instructions

The key operation when inputting/editing
 • "Ovrwrte"/"Insert" mode switches by pressing the Insert  key.

 • An instruction can be deleted by the Delete  key.

[Insert line] and [Delete line] operations can be done by the right click of the mouse

Reference

X0 Enter

Y0 Enter

X0 Enter

Y0 Enter

M0 Enter

M0 Enter

T0    K10 Enter

C0    K5 Enter

K1    D0   Enter

K20  D3  M10 Enter

Coil instructions for the timer and counter
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Appendix 1.9.3 Checking the content of the list input
Confi rm that there are no errors in the program created by list input in the circuit display.

Select  from the tool bar, or select
 [View] → [Circuit display] from the menu.

1)

Check whether the circuit created by list input 
is displayed.

2)

Select [Tools] → [Check program] to execute 
the program check, and check whether errors 
occur and the error steps.

3)
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SFC Program Outline

Appendix 2
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SFC Method (Reference)

(SFC=Sequential Function Chart)

Generally, relay sequences are used for sequences. However, as relay 

sequences express electrical operation, an experienced engineer is needed for 

design and maintenance in many cases. The circuit method, SFC, solves this 

problem.

SFC or sequential function charts express machine operation over time. SFC 

charts simplify programming on PLCs and free you from the need of having to 

perform complicated sequence design.

(1)Constantly changing sequences are expressed by process progression 

operation.

(2)Circuits that contain interlock circuits or redundant output need not be 

designed. (This is automatically processed by the PLC.)

(3)Overall control content and operation is easy to understand.

(4)A dynamic monitor function does away with the need for an experienced 

engineer for problem solving.

Main Features of SFC Method

(1)When the start pushbutton is pressed, the carrier advances 

and is immediately retracted when limit switch 3 operates.

(2)When limit switch 2 operates due to the carrier being 

retracted, carrier movement is paused for five seconds, and 

then the carrier advances again. When limit switch 4 

operates, the carrier is immediately retracted.

(3)When limit switch 2 finally operates, the carrier drive motor 

comes to a stop.

The following page shows the above operation expressed as an SFC.

The simple programming panel FX-10P/FX-20P or personal computer or other 

graphic programming panel is used for programming.

Operation

Motor

advance

 retract

Start button

pushbutton

Start pushbuttonPB

Advance LS3

LS2

LS2

LS4Advance

1st movement

5 secs

pause

2nd movement

Retract

Retract
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Training Machine's I/O Wiring Example

Appendix 3
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  S0 and S20 are called "states," and 

serve as auxiliary relays in the SFC.

  The first state of an SFC is called the 

"initial state," and is turned ON by a 

RUN pulse signal. (When the state is 

turned ON, its ON state is held.)

  S20 turns ON (ON state is held) as long 

as start signal X001 (transition condi-

tion) directly underneath is ON. (At the 

same time, S0 turns OFF by automatic 

processing.) As a result, advance Y000 

turns ON.

  Next, when small advance X003 turns 

ON, S21 turns ON and retract Y001 

turns ON. (At the same time, S20 and 

Y000 turn OFF by automatic process-

ing.)

  Then, likewise, when the transition con-

dition turns ON, the respective next 

state turns ON.

  Programs can be made using either in-

struction words or SFC charts.

Example of SFC using a Micro PLC

  "Initial state" refers to the state at the top of the SFC.

   "RUN pulse" is the signal that is generated when the PLC is in RUN 

mode.

   "Transition condition" refers to the transition signal that is used for mov-

ing between states.

   SFC operation is shown as follows.

X 001

X 003

X 002

T     0

X 004

X 002
Retract

limit switch 2

Large advance

limit switch 4

Timer Pause timer (5 secs)

K 50

Retract

Retract

Retract

limit switch 2

Small advance

limit switch 3
Advance

Advance

Start button pushbutton

S    0

S   20

S   21

S   22

S   23

S   24

Y 000

Y 000

Y 001

Y 001

T     0

S  20

S  21

Y 000

X 003 X 003

X 002 X 002

Y 001

S  20

S  21 Y 001

Y 000

Movement between operation 

states is performed as long as 

transition condition X003 

directly under the operation 

state has operated. After this, 

the transition source state 

becomes non-operational.

ReferenceReferenceReference



Appendix 3 I/O Wiring Diagram for Training Machine

Power supply
AC100V

Breaker Micro PLC

Programming panel

FX-10P

Lamp (red)

Variable resistor

Low   High

Buzzer

Magnetic contactor

Relay

Solenoid valve

Select switch

Proximity switch

Limit switch

Toggle switch

Pushbutton switch

Pushbutton switch

Contact
Motor

FX-I/0 DEMO Type Training Machine

1

L

N

X 000

Y 000

Y 001

Y 002

Y 003

Y 004

COM0

COM2

X 001

X 002

X 003

X 004

X 005

X 006

COM

~
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